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Procedural Paradigm
Programs consists of data and procedures
Procedures manipulate data passed to them
Programs organized by
Functional decomposition
Dataflow

Modules
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Object-Oriented Paradigm

Program consists of objects interacting

-t

\/\

Objects:

Know things
Do things
- Collaborate with other objects to perform task

Program are organized by:
- Classes

Inheritance hierarchies
- Subsystems
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Software Development & Modeling

Each stage of software development is modeling
- Analysis

Modeling the problem

Design

Modeling the solution

Implementation

Making the model run on a computer

Maintenance

Fixing and extending your model
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Modeling & Objects
Base system design on structure of problem
Objects are the bases of OO design
Objects considered more natural
Match way people think

Objects come from the problem domain



9/13/01 Doc 2 Classes part 1 Slide # 6
Example Problem

A refrigerator has a motor, a temperature sensor, a light and a

door. The motor turns on and off primarily as prescribed by

the temperature sensor. However, the motor stops when the

door is opened. The motor restarts when the door is closed if

the temperature is too high. The light is turned on when the

door opens and is turned off when the door is closed.

What are some objects?

What are some relationships between objects?

What are some attributes of the objects?

What are some behaviors of the objects?
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Two Views of Objects & Classes
Model View verses Language Syntax View
Object - Modeling Perspective
Abstraction in the domain with both
Attributes (things it knows)
Behavior (things it can do)
Class - Modeling Perspective
A class is a specification for an arbitrary number of objects

Objects that share the same behavior belong to the same
class

An object is an instance of a class
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Language View of Smalltalk class

Smalltalk classes are created and viewed with a class browser. As we cover Smalltalk
class syntax it will be useful for you to work with a browser. So we will first cover some
aspects of the browser, then we will look at the language details. There is a chicken-
and-egg problem here. To understand what the browser is showing, you need to know
the language details. It helps to use the browser to understand the language detalils.
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Viewing a Class

In most languages, source code is stored in a flat file and viewed with a text editor.
Smalltalk provides a set of code browsers to view and edit classes. We will look at
some of these browsers using the Point class as an example.

One way to find a Class in VisualWorks

B8

YisvalWworks NonCommercial lectureMotes.im

O

Hle Browse Toolz Changes [Database MWindow Help

B &2 B0 A2

lectureMotes.im created at August 31, 2001 3:01.02 pm, :I

2

In the Launcher select the "Class named..." item of the browse menu. You will get a
dialog window like:

EBrowse what cass?

I Poin

izancel E:l K I

In this dialog type the name of the class you are interested in. You can use wildcard
characters if you do not know the correct spelling of the class. The wildcard character
* will match any number of characters. The wildcard character # will match any single
character. In our example we will use Point. We get a browser that looks like:
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He Edit VYiew Class Protocol Method  Help

agniucde
AnthmeticWalue

- Categories of
methods

Class

Inheritance  class
Hierarchy S
N\

Smalltalk. Care defineClass: #Point

N ]
superdass: #{Core.Anthmetcyalue} ;I'O%gles Vlev¥hb%tween
indexedType: #one nstance methods,

private: false Clr?SS ?Ethpctljsl and
instance VarahleMames: '« y' sharead variables
dassinstanceVanableMNames: "

Class

imports: " e
category: ' Graphics- Geometry’ Definition
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Point Definition Partially Explained

Smalltalk.Core defineClass: #Point
superclass. #{ Core. ArithmeticValue}
indexedType: #none
private: false
InstanceV ariableNames. 'x y '
classinstanceV ariableNames: "
Imports: "
category: 'Graphics-Geometry'

Smalltalk.Core
Namespace in which Point class is defined

Core.ArithmeticValue
Parent class of Point

x andy
Points instance variables
All methods in Point can access X & y
No direct access to x & y outside of Point
Each Point object has separate copy of X & y
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Using Point
In a workspace type and execute:

lab]|
a .= Point "X:y: isaclass method that creates a point object"
x:1
y: 1.
b := Point
X: 3
y: -1.
Transcript
show: ax printString;
Cr;
show: b x printString.

This shows that the instance variables x have different values
in
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Viewing Point Methods

If you click on a category of methods the browser shows all methods in that category.
If you click on a method, the bottom pane will display the source code of the method.

He Edit Yiew Class Protocol Method Help
Objedt g faccessing [ |
Magnitucle —I X
AnthmeticValue y
VW
runcation and round off
polar coordinates
point functons )
converting - List of methods
in selected
¥ inztance (" dass Category
_-'I " shared varables

"Answer the ¥ coordinate "

&

Source code of

i selected method
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Viewing Class Methods

To view the class methods click on the class radio button in
the browser.

Fle Edit VYiew Class Protocol Metod Help

LDject P ecocdeHombUiteral Aray: _|
Magnituce theta:
Anthrmeticalue

=
 instance (v cazs

;] " szhared varables h ;l
]

X: xInteger y: yinteger
"Answer a new instance of a Point with coordinates xinteger and yinteger.”

Agelf basichew setX: xinteger setY': yinteger
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Some Important Features of the Browser

The browser menu provides some useful functionality. You should try the various
menu items to see what they do. We will cover a number of them here.

Class Comments

Select the Comment item in the View menu. The lower pane will show the class
comment.
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Class Menus

|T~lﬁ33 Protocol  Methc
* Fle Qut As...
Hardoopy
i S OEWNE
Spawn Hierarchy [

Add Elass F

Eromse 3

LR}

Mowve To... 3
iz
Fename Az...
Bemowe...

Initialize F

File Out As...

Put the source code of the class in a file. The default file format is XML. To change
the file format select the "Settings" item of the "File" menu in the Launcher. Then
click on the File-out Type" tab.

Hardcopy

Print the source code of the class. Details of printing differ between platforms and
settings on your computer. You may need to change the Printing settings by select
the "Settings" item of the "File" menu in the Launcher. Then click on the "Printing"
tab.

Spawn

Spawn Hierarchy

Open another browser on the selected class. Spawn Hierarchy shows the
inheritance hierarchy of the class.

Rename As...

Renames the class. You need to change all the references to the class by hand.
You will get a window with a list of all references to the class. The refactoring
browser automates this.

Remove
Deletes the class.
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Browse Submenu

M In=t Var Beferences ..
Move Ta.. » In=t Var Azzignments. ..
_ Pename As... In=t Yar Beads. .. M
Bemove. .. Shared Var References .
E e
Initialize lazs References
_ Local References To...
aSE'DIHt. Local Implementors OfF...
nd: [y <=py] :
Methods with Phraze. ..

Inst Var References...
Displays a list of the instance variables in the class. After selecting one, you get a
list of all methods that access the variable. When you select one of the methods,
you get the source code of the method.

Inst Var Assignments...

Similar to Inst Var References except shows only methods that change the value
of the selected variable.

Inst Var Reads...

Similar to Inst Var References except shows only methods that read the value of
the selected variable.

Class References

Shows a list of all methods in the system that directly reference the current class.
Referencing the class is not the same as referencing an instance of the class.

Local References To...

Prompts you for the name of a method or instance variable. Shows all places in
the class inheritance hierarchy where the method or instance variable is used.

Local Implementors Of...

Prompts you for the name of a method. Show all places in the class inheritance
hierarchy where the method is implemented.
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Protocol Menu Items

Bjgiocal Method |
= FAeOutds. [
Hardcopy i

| Spawn

Add... E
it

Rename &s...

Bemowe...

B

And...
|

File Out As...
Hardcopy

Spawn
Similar like items in the class menu, but act on the protocol

Add...

Allow you to add a new category of methods to the class.

Rename As...
Rename the selected category of methods

Remove
Remove the selected category of methods

Find...

Shows a list of all methods in the class. When you select a method from the list,
the browser shows the source code for the method.
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Method Menu Item

| Meppod  Help
E File Qut bz ﬁ
| Hardcopy

Spawn

Senders

—— —L —L

Implementors
Local Senders
Local Implementors

.. W WL

Mowve To...
Bemowe...

I

IFEl e SR E R

Edit Resource

Senders
Select a method then look at the Senders submenu. You will see the selected
method and all methods used in the selected method. Choosing one of these will
result in window with all methods in the system that send the chosen method .

Implementers
Same as Senders but results in a list of places where a method is implemented

Local Senders

Local Implementors
Same as above, but restricts the search to the class inheritance hierarchy
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Defining a New Class

We will go through the steps of creating a new class called SimpleCircle.

Creating a Namespace

Classes exist in a namespace, so we will create a new namespace for our class.
Since a hamespace can hold many classes we do not have to create a namespace
each time we create a class.

Open a system browser by clicking on the "System Browser" icon in the Launcher.

@& 2 W
EE] Swstern Browser Er
I

You will get a browser like:

Fle  Edit Yew Nameszpace Class Pn

ALU_Into -
A01_Setup
[+ Core AD1_Setup_
~Examp AD1_Selup

~Extem: = ADZ2 Lesson
4| | b ADZ2_Lesson
ADZ2 _Lesson
= Smaliiak Categon||  AD2 Lesson 7]
| Ermalltalk. Root defineMarme Space: #Small
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In the left most pane select the Smalltalk namespace. Now select the "Namespace
item in the Add submenu of the Namespace menu.

Wigw | MNamespace Class Protocol  Method

Core ~
= xiem:
= yctom; - I *

+ Mowve To...
ST T

. RAle Dut Az EJ
m = pann
Zhared Vanable ik
1 -

In the lower pane of the browser you will see the template:

Smalltalk defineNameSpace: #NameOfPool
private: false
imports: '
OtherNameSpace.*
private Smalltalk.*

category: 'Asyet unclassified'
To create a namespace called CS535 edit the template so it looks like:

Smalltalk defineNameSpace: #CS535
private: false
imports: '
private Smalltalk.*

category: 'Course-Examples

Now accept the changes in the lower pane. This can be done on a PC using right
mouse button to get a pop-menu that contains "Accept”. Or you can use the browser's
"Edit" menu. Once you have accepted the text, you will see the CS535 namespace
listed under Smalltalk.

The imports: 'private Smalltalk’ allows all classes in the new namespace to use short
names to reference all classes in the standard Smalltalk library.

The category: 'Course-Examples' allows us to find the class in the given category
when we use the category browser.
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Creating a Class in the new Namespace

Select the CS535 namespace in the left most pane. Now select the "Fixed Size" item
in the "Add Class" submenu of the "Class" menu of the browser.

e |g|ass Protocol  Method  Help

T |F HIE __I
Heraeapsy

T

et Hieraray

Add Clazs

B se ¥

Indexed
Evte Indexed

#

L [e gty = e F

In the lower pane you will the template:

Smalltalk.CS535 defineClass: #NameOfClass
superclass: #{ NameOf Superclass}
indexedType: #none
private: false
instanceV ariableNames: 'instVarNamel instVarName2'
classlnstanceVariableNames: "
imports: "
category: 'Asyet unclassified'

Edit the template to look like:

Smalltalk.CS535 defineClass: #SimpleCircle
superclass: #{ Object}
indexedType: #none
private: false
instanceV ariableNames: 'origin radius’
classlnstanceV ariableNames: "
imports: "
category: 'Course-Examples

Accept the changes. When you do this, you will see the class listed in one of the
upper level panes.
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Using the Class

The class SimpleCircle does not do much, but we can still create an instance. In a
workspace evaluate the following code with "Print it". What happens? Evaluate the
code with "Inspect it". What happens?

SimpleCircle new
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Adding Methods

Now to add a method to the class. Make sure the class is selected in the browser.
Select the "Add..." item in the Protocol menu.

Protocol  Method

B EENETAE

Herdoapy

EEET

= =

EET e L

mi_l

Bnd...

You will be prompted to enter a category name. Enter "accessing". Once this is done
the lower pane will contain the template:

message selector and argument names
"comment stating purpose of message”

| temporary variable names |
Statements

Edit this code to be:

radius; aNumber
radius := aNumber

Accept these changes. After accepting these changes select all the text in the lower
pane and replace it with:

area
Aradius * radius* Float pi

Accept these changes. Your class now has two methods: area and radius. In a
workspace evaluate the following code with "Print it". Is your result reasonable?

| circle|

circle := SimpleCircle new.
circleradius: 2.0.
circlearea

You may wish to save your image so you do not lose these changes.



